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Chapter

Preinstallation and
planning
This chapter contains the following topics:
■

“Prerequisites” on page 8

■

“Installation requirements” on page 8

■

“Licensing” on page 15

■

“Planning the installation” on page 17
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Prerequisites
Review the following prerequisites:
■

Review the Veritas Cluster Server Release Notes.

■

Review the requirements.
See “Installation requirements” on page 8.

■

Exit all running applications.

Installation requirements
Veritas Cluster Server is supported on Windows-certified network servers
containing one or more processors. Veritas Cluster Server supports clusters of
up to 32 nodes.

Supported hardware
Refer to the Hardware Compatibility List on the Symantec Support Web site at
http://www.symantec.com/business/support/index.jsp to determine the
approved hardware. The compatibility list contains information about
supported hardware and is updated regularly. Before installing Veritas Cluster
Server, review the current compatibility list to confirm the compatibility of your
hardware and software.

Supported software
Supported application versions and the operating systems are listed below. You
must install the operating system in the same path on all systems. For example,
if you install Windows 2003 on C:\WINDOWS of one node, installations on all
other nodes must be on C:\WINDOWS. Make sure that the same drive letter is
available on all nodes and that the system drive has adequate space for the
installation.
Note: All VCS nodes must run the same Windows operating system and service
pack level as well as the same VCS version and service pack level.
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Microsoft Exchange servers and their operating systems
Table 1-1

Microsoft Exchange servers and operating systems

Microsoft Exchange servers

operating systems

Microsoft Exchange Server
2007 Standard Edition or
Enterprise Edition (SP1
supported)

■

Windows Server 2003 x64 (Standard Edition,
Enterprise Edition, Datacenter Edition) (SP1
required for all editions, SP2 supported)

■

Windows Server 2003 R2 x64 (Standard Edition,
Enterprise Edition, Datacenter Edition)

Microsoft Exchange Server 2003
Standard Edition or Enterprise
Edition (SP2 supported)

■

Windows Server 2003 (Standard Edition,
Enterprise Edition, or Datacenter Edition) (SP1
required for all editions, SP2 supported)

■

Windows Server 2003 R2 (Standard Edition,
Enterprise Edition, or Datacenter Edition)

■

Oracle versions and their operating systems
Table 1-2

Oracle versions and operating systems

Oracle versions

Windows Server versions

Oracle 9i, Release 2 (9.2.0.2)
Standard Edition, Enterprise
Edition

■

Windows Server 2003 (32-bit) Standard Edition,
Enterprise Edition, or Datacenter Edition (SP2
required for all editions)

■

Windows Server 2003 (32-bit) R2 Standard
Edition, Enterprise Edition, or Datacenter
Edition (SP2 required for all editions)

■

Windows Server 2003 for Itanium-based
Systems Enterprise Edition or Datacenter
Edition (SP2 required for both)

Oracle 10g, Release 1 (10.1.0.2)
Standard Edition, Enterprise
Edition
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Oracle versions

Windows Server versions

Oracle 10g, Release 2 (10.2.0.1.0)
Standard Edition, Enterprise
Edition

■

Windows Server 2003 (32-bit) Standard Edition,
Enterprise Edition, or Datacenter Edition (SP2
required for all editions)

■

Windows Server 2003 (32-bit) R2 Standard
Edition, Enterprise Edition, or Datacenter
Edition (SP2 required for all editions)

■

Windows Server 2003 for Itanium-based
Systems Enterprise Edition or Datacenter
Edition (SP2 required for both)

■

Windows Server 2003 (64-bit) Standard Edition,
Enterprise Edition, or Datacenter Edition (SP2
required for all editions)

■

Windows Server 2003 (64-bit) R2 Standard
Edition, Enterprise Edition, or Datacenter
Edition (SP2 required for all editions)

Microsoft SQL Servers and their Microsoft SQL Servers and
their operating systems
Table 1-3

Microsoft SQL Servers and operating systems

Microsoft SQL Servers

operating systems

Microsoft SQL Server 2000
Standard Edition or Enterprise
Edition (SP4 required)

■

Windows Server 2003 (32-bit) Standard Edition,
Enterprise Edition, or Datacenter Edition (SP1
required for all editions, SP2 supported)

■

Windows Server 2003 R2 (32-bit) Standard
Edition, Enterprise Edition, or Datacenter
Edition

Microsoft SQL Server 2000 (64bit) Enterprise Edition

Microsoft SQL Server 2000
Standard Edition or Enterprise
Edition (SP4 required for all
editions)

Windows Server 2003 for Itanium-based
systems: Enterprise Edition or Datacenter
Edition (SP1 required for all editions, SP2
supported)
■

Windows Server 2003 x64 Editions: Standard
x64 Edition, Enterprise x64 Edition, or
Datacenter x64 Edition (SP1 required for all
editions, SP2 supported)

■

Windows Server 2003 x64 R2 Editions: Standard
x64 R2 Edition, Enterprise x64 R2 Edition, or
Datacenter x64 R2 Edition (SP1 required for all
editions, SP2 supported)
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Table 1-3

Microsoft SQL Servers and operating systems

Microsoft SQL Servers

operating systems

Microsoft SQL Server 2005, (32bit) Standard Edition or
Enterprise Edition (SP1 required
for all editions)

■

Windows Server 2003 (32-bit) Enterprise Edition
or Datacenter Edition (SP1 required for all
editions, SP2 supported)

■

Windows Server 2003 R2 (32-bit) Standard
Edition, Enterprise Edition, or Datacenter
Edition (SP2 supported for all editions)

■

Windows Server 2003 Standard x64 Edition,
Enterprise x64 Edition, or Datacenter x64
Edition (SP2 supported for all editions)

■

Windows Server 2003 x64 R2 Editions: Standard
x64 R2 Edition, Enterprise x64 R2 Edition, or
Datacenter x64 R2 Edition (SP2 supported for all
editions)

■

Windows Server 2003 for Itanium-based
systems: Enterprise Edition or Datacenter
Edition (SP1 required for all editions, SP2
supported)

■

Windows Server 2003 Standard x64 Edition,
Enterprise x64 Edition, or Datacenter x64
Edition (SP2 supported for all editions)

■

Windows Server 2003 x64 R2 Editions: Standard
x64 R2 Edition, Enterprise x64 R2 Edition, or
Datacenter x64 R2 Edition (SP2 supported for all
editions)

Microsoft SQL Server 2005, (64bit) Standard Edition or
Enterprise Edition (SP1 required
for all editions)

Note: Microsoft SQL Server 2000 and Microsoft SQL Server 2005 can exist in the
same cluster and operate on or fail over to the same systems. However, only one
default instance can exist on a system at one time. Additional instances that
operate on or fail over to that system must be named instances. The number of
named instances is limited only by the normal limit of instances for that version
of SQL Server.

Supported Network Appliance applications
■

Network Appliance SnapManager for Exchange 3.2 with
Exchange Server 2003

■

Network Appliance SnapManager for Exchange 4.0 with
Exchange Server 2007

■

Network Appliance SnapManager for SQL 2.0
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■

Network Appliance Data ONTAP 7.2

■

Network Appliance SnapDrive 4.1, 4.2, and 5.0
When installing SnapDrive, you must specify a user account in the
SnapDrive Service Credentials dialog box. The user account must be a
domain user and part of the Administrators group of the local system and
the filer.

■

Microsoft iSCSI software Initiator 2.02 and 2.05

■

NetApp FCP Attach Kit 3.0, Windows Host Utilities 3.0
If you plan to use Fibre Channel (FC) for connecting the LUNs, ensure that
you install the NetApp FCP Attach Kit or Windows Host Utilities on all the
cluster nodes. Refer to NetApp documentation for more details.
If you are setting up a failover environment over Fibre Channel (FC), install
the following Microsoft Windows hotfixes required for NetApp SnapDrive
version 4.1, on each node in the VCS One server farm:
■

Q903081_W2K3_SP1 - Storport.sys (Required: 5.2.3790.2497)

■

Q898790 - mountmgr.sys (Required: 5.2.3790.2443)

■

Q902837 - Classpnp.sys (Required: 5.2.3790.2473)

■

Q891957 - Volsnap.sys (Required: 5.2.3790.2476)

■

Q912848 - ftdisk.sys (Required: 5.2.3790.2607)

Q908249 - Ntoskrnl.exe (Required: 5.2.3790.2534)
Depending on your setup environment, the NetApp SnapDrive 4.1 installer
may still display a list of Microsoft hotfixes that are required to install,
before installing SnapDrive 4.1. Ensure that you download and install all
the required Microsoft hotfixes.
■

Note: After installing the Microsoft hotfixes required for SnapDrive 4.1, you
may not be able to uninstall these hotfixes.

Hardware requirements
Memory
■

Minimum required: 1GB

■

Recommended: 2GB

System processor
■

Minimum required: 300 MHz Pentium II

■

Recommended: 550 MHz Pentium III or higher
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Display resolution
■

Recommended: 1024 x 768 pixels or higher

VCS Cluster Manager (Java Console and Cluster Management Console) requires
an 8-bit (256 color) display and a graphics card able to render 2D images.

System requirements
■

Shared disks to support applications that migrate between nodes in the
cluster. Campus clusters require more than one array for mirroring. Disaster
recovery configurations require one array for each site.

■

SCSI or Fibre Channel Host Bus Adapters (HBAs), or iSCSI Initiator
supported NICs to access shared storage.

■

Two NICs: one shared public and private, and one exclusively for the private
network; Symantec recommends three NICs: one public and two for the VCS
private network.

Network requirements
■

Verify the systems on which you install the software are part of a Windows
Active Directory domain.

■

Static IP addresses for the following purposes:
■

One IP address per site for each virtual server

■

One IP address for each physical node in the cluster

■

One IP address per cluster when configuring Notification, VCS Web
Console. The same IP address can be used for all options.

■

Configure name resolution for each node.

■

Verify the availability of DNS Services. AD-integrated DNS or BIND 8.2 or
higher are supported. Make sure a reverse lookup zone exists in the DNS.
Refer to the application documentation for instructions on creating a
reverse lookup zone.

■

DNS scavenging affects virtual servers configured in VCS because the
Lanman agent uses Dynamic DNS (DDNS) to map virtual names with IP
addresses. If you use scavenging, then you must set the DNSRefreshInterval
attribute for the Lanman agent. This will enable the Lanman agent to
refresh the resource records on the DNS servers. See the Lanman agent
description in the Veritas Cluster Server Bundled Agents Reference Guide for
more information.

■

Make sure that the NetApp filers reside in the same domain as the systems.
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■

Make sure that the NetApp filers are reachable; ensure that you can ping the
filers using the DNS name.

■

If you plan to set up a disaster recovery configuration, make sure that:
■

The volumes at both sites are of the same size.

■

The NetApp filers can replicate in both directions.

■

Configure the Common Internet File System (CIFS) for each volume. See the
Network Appliance documentation for instructions.

■

If you plan to use Fibre Channel (FC) for connecting the LUNs, type
hba_info on the command prompt, and verify that the FC initiators are
displayed.
If FC initiators are not displayed, install the mini port driver provided by
your vendor and run the command again to verify that the FC initiators are
displayed.

■

Ensure that the LUNs are mounted. In case of MPIO, ensure that the LUNs
are mounted using the required initiators.
Note: MPIO support is available only with FC.

■

If the domain controller and the computer running the installation program
are on different subnets, the installer may be unable to locate the
computers selected for installation. In this situation, after the installation
program displays an error message, type the host names and the IP
addresses of the missing computers manually.

Supported browsers
Veritas Cluster Server Management Console is supported on the following
browsers:
■

Microsoft Internet Explorer 6.0 with SP2 or newer

■

Firefox 1.5 or newer

Veritas Cluster Management Console requires the Macromedia Flash Plugin
v8.0.
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Firewall and anti-spyware considerations
Disable spyware monitoring and removal software before installing this
product. You must disable firewalls to enable discovery of the local client. On
systems running Windows Server 2003 SP1, you must disable the Windows
Firewall or configure it to allow exceptions to the Remote Administration and
File and Printer Sharing services.
■

If you have configured Windows Firewall, add the following to the Firewall
Exceptions list:
■

Port 14150 or the VCS Command Server service,
%vcs_home%\bin\CmdServer.exe.
Here, %vcs_home% is the installation directory for VCS, typically
C:\Program Files\Veritas\Cluster Server.

■

Port 14141

Ensure that the firewall settings allow access to the services and ports used by
VCS. See Appendix A, “Services and ports used by VCS” on page 55 for a list of
services and ports used by VCS.

Licensing
Each copy of Veritas Cluster Server including all options and agents, whether
used on a physical server or within a virtual machine, must be licensed
according to the conditions set forth in the sections below. Each Licensed
Software license specifies the number of instances of the licensed software you
may run on a particular server at one time.
Table 1-4 lists Veritas Cluster Server editions and the additional licensing terms
that apply.
Table 1-4

Veritas Cluster Server licensing terms

Microsoft Operating
System Edition
■

Server Edition

■

Standard Edition

■

Web Edition

■

Advanced Edition

■

Enterprise Edition

Datacenter Edition

Veritas Cluster Server licensing terms
A separate license for the licensed software is required for
each virtual or physical server, where the software is
installed.
For each license, you may run one instance of the licensed
software on one physical server and up to four simultaneous
instances of the licensed software on virtual servers located
on the physical server.
For each license, you may run one instance of the licensed
software on one physical server and an unlimited number of
virtual servers located on the physical server.
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Evaluation license key
An evaluation license key is embedded in the product. To use this key, click Next
at the license key entry screen of the product installer. This license key is valid
for a limited evaluation period only.

Virtual Server license policy
Each copy of the Veritas Cluster Server including all options and agents,
whether used on a physical server or within a virtual machine must be
separately licensed. Each Licensed Software license specifies the number of
instances of the licensed software you may run on a particular server at one
time.

License management
The product installer allows you to add and remove specific licenses. Adding a
license for an option does not install the option. Use the Add/Remove function
to install an option. License keys support installation on multiple systems.
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Best practices
■

Symantec recommends that you configure Microsoft Exchange Server and
Microsoft SQL Server on separate failover nodes within a cluster.

■

Symantec recommends three network adapters (two NICs exclusively for the
private network and one for the public network).
When using only two NICs, implement the second private link as a lowpriority link over a public interface.

■

Route each private NIC through a separate hub or switch to avoid single
points of failure.

■

Verify that you have set the Dynamic Update option for the DNS server to
Secure Only.

Planning the installation
During the installation, the product installer automatically installs Veritas
Cluster Server. You may select other applicable options during the installation.
You may also choose to install simultaneously on more than one system during
the installation process.
After the initial installation, run the VCS Cluster Configuration Wizard (VCW) to
complete the VCS cluster configuration. The VCW presents the opportunity to
configure optional VCS features including security options, Cluster
Management Console, notification, and the global cluster wide-area connection
resource.
Depending on your environment you may choose to configure the Symantec
Product Authentication Service and the Cluster Management Console on
systems outside the cluster.
Review the following information and decide how you want to configure your
environment:
■

About Symantec Product Authentication Service

■

About Veritas Cluster Management Console

■

About notification

■

About global clusters
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About Symantec Product Authentication Service
Symantec Product Authentication Service allows the security administrator to
configure authentication to provide a single sign-on service for Symantec
applications. In this case, users need log-on only once to a single Symantec
application, and other applications can then use the credentials acquired
through the first logon.
Symantec Product Authentication Service provides the ability to configure a
cluster in secure mode. Symantec Product Authentication Service secures
communication between cluster nodes and clients, including the Java console,
by using digital certificates for authentication and SSL to encrypt
communication over the public network.
To configure the cluster in secure mode, Veritas Cluster Server requires you to
specify and configure a system in your environment as a root broker and all
nodes in the cluster as authentication brokers.
■

Root broker
A root broker serves as the main registration and certification authority; it
has a self-signed certificate and can authenticate other brokers.

■

Authentication brokers
Authentication brokers serve as intermediate registration and certification
authorities. Authentication brokers have certificates that are signed by the
root. Each node in the cluster serves as an authentication broker.

The Symantec Product Authentication Service Quick Start Guide describes the
best practices and options for configuring the root broker in your environment.

About Veritas Cluster Management Console
Veritas Cluster Management Console is a high availability management solution
that enables monitoring and administering clusters from a single web console.
You can configure Cluster Management Console to manage a single cluster,
multiple clusters, or both.
■

If you want to use Cluster Management Console to manage multiple clusters,
you must set up a standalone management server.

■

If you want to use the Cluster Management Console to manage a single
cluster, choose the option to configure the Cluster Management Console,
also known as the Web console from the VCS Configuration Wizard.
Configuring the Cluster Management Console may be done during initial
cluster configuration or at a later time.

For more information, see the Veritas Cluster Server Management Console
Implementation Guide.
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About notification
You can configure Veritas Cluster Server to send event notification either
through SMTP email notification or SNMP traps.
Configuring the notifier process may be done during initial cluster
configuration or at a later time using the VCS Configuration wizard.
See the Veritas Cluster Server Administrator’s Guide.

About global clusters
A global cluster consists of two or more local clusters linked together. Global
clusters provide the ability to fail over applications between geographically
distributed clusters when disaster occurs.
Global clusters may be configured either through the Disaster Recovery
Configuration Wizard available from the Solutions Configuration Center or
through the Global Group Configuration Wizard. Both processes require a widearea connector resource for inter-cluster communication. This resource is
configured using the VCS Configuration Wizard.
The Global Group Configuration Wizard and VCS Cluster Configuration Wizard
(VCW) are described in the Veritas Cluster Server Administrator’s Guide.
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Chapter

Installing Veritas Cluster
Server
This chapter contains the following topics:
■

“Installing the software using the product installer” on page 22

■

“Installing the software from the command line” on page 25

■

“Configuring Veritas Cluster Server” on page 28

■

“License management” on page 28

■

“Uninstalling using the product installer” on page 29

■

“Uninstalling from the command line” on page 31
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About installing Veritas Cluster Server
This chapter covers installing Veritas Cluster Server. It also covers licensing,
adding features, and uninstalling information.

Installing the software using the product installer
Before installing the software on remote systems running Windows 2003, you
must modify the driver signing options to ignore warning messages about
software authentication.
Note: Before installing Veritas Cluster Server, make sure you have uninstalled
any previous versions of SFW, SFW HA, or Veritas Cluster Server.
To modify driver signing options for Windows 2003
1

2

Open the Driver Signing Options dialog box by using either of the following
methods:
■

From Windows Explorer, right-click My Computer, and click
Properties. On the Hardware tab, click Driver Signing in the Device
Manager box.
or

■

Open the Control Panel and double-click System. On the Hardware tab,
click Driver Signing in the Device Manager box.

In the Driver Signing Options dialog box, check Ignore, and click OK.

To install the products using the installer
The examples in the following procedure are based on a Custom/Complete
installation.
1

From Windows Explorer, navigate to the root directory of the Veritas Cluster
Server installation media and double-click Setup.exe.

2

Click Product Installation in the left pane, then click the product name,
Veritas Cluster Server 5.1 for Windows.

3

Click Complete/Custom.
The Complete/Custom installation installs server components and optional
client components. Click Administrative Console if you wish to install only
the client components. This will install the VCS Java Console.

4

Review the information on the Welcome panel and click Next.
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5

Read the License Agreement by using the scroll arrows in the view window.
If you agree to the license terms, click I accept the terms of the license
agreement and then click Next.

6

In the Enter a license key field, type the license key, click Add, and then click
Next. The License Key Details section displays more information about the
selected key.
If you do not have a license key, click Next to use the embedded evaluation
license key.
To delete a license key, select the key from the key list and click Remove.

7

On the Option Selection panel, check the following product options and click
Next:

8

■

Veritas Cluster Server 5.1 for Windows (Server Components)

■

Global Clustering Option - if you plan to configure a disaster recovery
environment.

■

High Availability Hardware Replication Agents

■

High Availability Application Agents

■

High Availability Database Agents
■

Veritas Cluster Server Database Agent for SQL

■

Veritas Cluster Server Database Agent for Oracle

■

Enterprise Vault (EV) Cluster Setup Wizard

■

Product Documentation

■

Veritas Cluster Server 5.1 for Windows (Client Components) - This will
install the VCS Java Console on the same nodes where the server
components are installed.

On the Computer Selection panel, specify the domain and nodes for the
installation and click Next.

Domain

Select the domain from the drop-down list.

Computer

Select the computer name from the dropdown list.
This may take some time to populate depending on the
domain and network size, speed, and activity.
Alternatively, if you know the computer name, type the name
in the Computer field.

Add

Click Add to add the computer for installation.

Selected
computers for
installation

The Selected computers for installation section displays the
list of computers that you have added for installation. To
remove a computer, click a computer name and click Remove.

23

24 Installing Veritas Cluster Server
Installing the software using the product installer

Install Path

The Install Path field displays the default path for
installation. To specify a different installation path for a
computer:
1

Select the computer name from the Selected computers for
installation list.

2

Type the path in the Install Path field.

3

Click Change and then click Yes to confirm the changes.
To restore the default installation path for a computer:
Select the computer name from the Selected computers for
installation list and then click Default.

9

After the installer validates the systems for the installation, click Next. If an
error occurs, address the problem described in the Details box, click Validate
Again, and click Next.

10 Review the summary information and click Install. If necessary, click Back
to make changes.
11 If an installation is not successful on any of the systems, the status screen
shows a failed installation. If the installation is successful on all systems,
click Next after the progress indicator shows the installation is completed.
If a security alert asks you to accept the Veritas driver software, click Yes.
12 Review the installation report and click Next.
13 Click Finish to complete the installation.
14 Click Yes to reboot the local node.

Resetting the driver signing options
To ensure a secure system environment, after completing the installation
sequence, reset the driver signing options on each computer to the original state
of Warn or Block.
To reset the driver signing options
1

Open the Control Panel and click System.

2

Select the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.

4

Click OK to close the Driver Signing Options dialog box, and then click OK
again to close the System window.

5

Repeat for each computer.
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Installing the software from the command line
You can perform a silent installation from the command prompt using the
Setup.exe command. A silent installation can be performed only on one node
at a time. See the examples at the end of this section for reference.
To start the installation from the command window
1

Insert the product software disc into a drive connected to the system.

2

Click Start > Run.

3

Enter cmd in the Open field and click OK.

4

From the command window, navigate to the root directory of the product
software disc.

5

Use the following command to install the software:
Setup.exe /s Solution=<Solution> Install_mode=<InstallMode>
Installdir=<"InstallDirPath"> Reboot=<RebootMode>
target=<”machine name”> Licensekey=<"LicenseKey">
options=<"a,b,c,...">

where the maximum length of the argument string is 512 characters.
Note: To install the server and matching client components, run the Setup.exe
/s command twice, once with the Solution parameter set for the server
component and the next set for the client component. If you use a script to
install the server and client, consider first installing the client and then the
server, so that the script can reboot the system after server installation.

Parameters for setup.exe
Information about the possible parameter values follows.
Table 2-1

Parameters for installing the product

Parameter

Use

Solution

Set to the type of installation.
6 = VCS (Server Components)
7 = VCS (Client Components)
The default setting is 6 for server components.
Example: SOLUTION=6
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Table 2-1

Parameters for installing the product

Parameter

Use

InstallMode

Set to indicate an installation or uninstallation.
1 = To install
5 = To uninstall
The default setting is 1 to install.
Example: INSTALL_MODE=1

Installdir (optional) Set the path of the installation directory. The path must
start and end with a quotation mark (").
The default setting is SystemDrive:\Program
files\Veritas
Example:
INSTALLDIR="C:\InstallationDirectory"
Reboot (optional)

Setting for the automatic reboot of the system at the
completion of the installation.
0 = No reboot
1 = Reboot
The default setting is 0 for no system reboot.
Example: REBOOT=1

Note: Reboot the system at the end of installation to ensure that the software drivers for
the server component are installed correctly. You do not have to reboot after installing
the client.
Target (optional)

Specify the machine name for the system where you want
to install the software. Make sure you place the machine
name between quotes.
localnode is the default setting.
Example: “PC177VM-3”

LicenseKey (optional) Set the license key for the installation. Enter multiple keys
by separating them with a comma (e.g. 123-345-567-789123, 321-543-765-789-321, etc.) The license key must start
and end with a quotation mark (").
LicenseKey has no default setting.
Example: LICENSEKEY="123-234-123-234-345"
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Table 2-1

Parameters for installing the product

Parameter

Use

Options (optional)

Set the desired options, if any. The option must start and
end with a quotation mark ("). Multiple options can be
entered, use a comma as a separator.
There are no default settings.
The options for VCS are:
■

ntap

■

GCO

■

exchange

■

sql

Example: OPTIONS="GCO"

Example for Setup.exe: Client installation
This command installs the client components at the specified installation path
and tells the system not to reboot at the end of the installation.
Setup.exe /s Solution=7 Install_mode=1
Installdir="C:\InstallationDirectory"

Example for Setup.exe: Server installation
This command installs the server components in the directory
C:\InstallationDirectory and tells the system to reboot at the end of the
installation. It also installs with a license key of 123-234-123-234-345, and with
the GCO option.
Setup.exe /s Solution=6 Install_mode=1
INSTALLDIR="C:\InstallationDirectory" REBOOT=1
licensekey="123-234-123-234-345" options="GCO,SQL"
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Configuring Veritas Cluster Server
After installing the software, set up the components required to run Veritas
Cluster Server. The VCS Configuration Wizard sets up the cluster infrastructure,
including LLT and GAB, and provides an option of configuring the Symantec
Product Authentication Service in the cluster. The wizard also configures the
ClusterService group, which contains resources for Cluster Management
Console (Single Cluster Mode) also referred to as Web Console, notification, and
global clusters.
■

If you plan to set up a disaster recovery environment, configure the widearea connector process for global clusters.

■

When configuring a user account for the VCS Helper service, choose the
administrative account set up on the filer.

For instructions, see the chapter on Getting Started with VCS in the Veritas
Cluster Server Administrator’s Guide.

License management
The product installer allows you to add or remove license keys for options in
your installation of Veritas Cluster Server client and server components.
To add or remove license keys
1

Open the Windows Control Panel and click Add or Remove Programs.

2

Select Veritas Cluster Server 5.1 for Windows (Server Components) and
click Change.

3

The Symantec Product Installer screen appears. Select License
Management. Click Next.

4

The license key screen appears. Enter the license key you want to add and
click Update. If you want to remove a license key, select the license key in the
Licenses field and click Remove.

5

Click Finish.

Installing Veritas Cluster Server
Uninstalling using the product installer

Uninstalling using the product installer
In order to uninstall the software from remote computers, the local computer
where you uninstall must have Veritas Cluster Server installed on it.
The steps in the following procedure apply to a Veritas Cluster Server
uninstallation of the server and client components from a Windows 2003
system. The steps for uninstalling the client components and high availability
server are similar.
Note: You must unconfigure the cluster before uninstalling Veritas Cluster
Server.
To uninstall using the product installer
1

In the Windows Control Panel, select Add or Remove Programs.

2

Click Veritas Cluster Server 5.1 for Windows (Server Components).

3

Click Remove.

4

Review the Welcome screen and click Next.

5

Select both checkboxes to uninstall the client components in addition to the
server components. Click Next.

6

Select the systems that you want to uninstall from the Domain and
Computer drop-down menus and click Add. Optionally, type the computer’s
name in the Computer field. Repeat to uninstall from other systems.
To remove a system from the Selected computers for uninstallation list,
click the system and click Remove.

7

Click Next.

8

On the Validation screen, the installer checks the prerequisites for the
selected systems and displays the results. Review the information and once
the status is Accepted, click Next.
If a system fails validation, click the system in the systems list to display
information about the failure. Address the problem and click Validate Again
to repeat the validation process.

9

The Summary screen appears and displays the settings and systems selected
for uninstallation. Review the summary and then click Uninstall.

10 The Uninstall Status screen displays status messages and the progress of
uninstallation.
If an uninstallation fails, the status screen shows a failed uninstallation.
Click Next to review the report, address the reason for failure, and retry this
step on that computer.

29

30 Installing Veritas Cluster Server
Uninstalling using the product installer

11 When complete, review the uninstall summary and click Next.
12 Reboot the remote nodes. Note that you cannot reboot the local node now.
■

Click the check box next to the remote nodes that you want to reboot.

■

Click Reboot.

■

When the remote nodes have finished rebooting successfully, the
Reboot Status shows Online and the Next button is available. Click
Next.

■

Once the remote nodes have rebooted, click Next.

13 On the Thank You screen, click Finish.
14 Click Yes to reboot the local system.
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Uninstalling from the command line
You can silently uninstall the Veritas Cluster Server software from the
command prompt using the setup.exe command.
At the end of this section, two command examples show how to uninstall the
client components.
See “Setup.exe example: Uninstalling the client components” on page 32. See
“Setup.exe example: Uninstalling the server components” on page 32.
To start the uninstallation from the command prompt
1

Open a command window by clicking Start > Run.

2

Enter cmd in the Open field and click OK.

3

In the command window, navigate to the root directory of the product CD.

4

Use the following command syntax to silently uninstall Veritas Cluster
Server:
Setup.exe /s Solution=<solution> Install_mode=InstallMode
reboot=<RebootMode> [Node=PC177VM-3]

Information about the possible parameter values follows:
Table 2-2

Parameters for uninstalling the product

Parameter

Use

/s

Set for silent mode.

Install_mode

Set to indicate an install or uninstall.
1 = To install
5 = To uninstall
The default setting is 1 to install. Set this parameter to 5 for
uninstall.
Example: Install_mode=5

Solution

Set to the type of uninstallation.
6 = VCS 5.1 (Server Components)
7 = VCS 5.1 (Client Components)
Example: Solution=6
Note: To uninstall the server and matching client components,
run two setup.exe /s commands, one with the Solution
parameter set for the server component and the other set for the
matching client component.
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Table 2-2

Parameters for uninstalling the product

Parameter

Use

Reboot

Setting for the automatic reboot of the system at the completion
of the installation.
0 = No reboot
1 = Reboot
The default setting is 0 for no system reboot.
Example: Reboot=1

Node

Set the node name. Specify only one node at a time.
The local node is the default setting when the node is
unspecified.
Example: Node=”PC177VM-3”

Setup.exe example: Uninstalling the client components
This sample command completely uninstalls the client components, and tells
the system not to reboot at the end of the uninstallation.
Setup.exe /s Solution=7 Install_mode=5 Reboot=0

Setup.exe example: Uninstalling the server components
This sample command completely uninstalls the server components, and tells
the system to reboot at the end of the uninstallation.
Setup.exe /s Solution=6 Install_mode=5 Reboot=1

Chapter

Upgrades
This chapter contains the following topics:
■

“Upgrading to Veritas Cluster Server 5.1” on page 34

■

“Microsoft Service Pack upgrades” on page 42

■

“Upgrading an Exchange Server cluster” on page 50

■

“Upgrading a SQL Server cluster” on page 51
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Upgrading to Veritas Cluster Server 5.1
This section describes the tasks to be carried out when upgrading to Veritas
Cluster Server 5.1.
Note: If you are upgrading from VCS 4.3 to VCS 5.1, verify the version of
Snapdrive installed. If you have Snapdrive 3.2 installed and you upgrade to VCS
5.1, all the wizards that were working before the upgrade, will stop working. You
must upgrade to VCS 5.1 first and then upgrade the Snapdrive installation to
version 4.1 or above.

Preparing to upgrade to VCS 5.1
When upgrading the product, perform the following general pre-upgrade tasks:
■

Back up all your data.

■

Back up the system state.

■

Check the hardware requirements for the software upgrade.

■

Check to see if you need to update the Microsoft Active Directory to support
the upgraded software.

■

Test the system after each upgrade, especially after applying product
upgrades to meet the minimum version required. An incremental upgrade
eases the troubleshooting process.

Removing VCS Management Console 5.1
If one or more nodes in the cluster have Veritas Cluster Server Management
Console 5.1 installed, you must remove the management console before
upgrading VCS. You can reinstall the management console after the upgrade.
See “Re-installing VCS Management Console 5.1” on page 40.
To remove VCS Management Console 5.1
1

Stop the VCS Management Console. If the management console is clustered,
take the CMC_MS service group offline.

2

Back up the console’s data directory and datadir.conf files. Typically, the
files are located at the following paths:
■

C:\Program Files\Symantec\VRTScmcm

or
■

C:\Program Files (x86)\Symantec\VRTScmcm
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3

Remove VCS Management Console 5.1 from all nodes in the cluster using
Windows Add/Remove Programs.

Saving and closing the cluster configuration
Before starting the upgrade process, use the VCS Java Console to “save and
close” the configuration. This operation involves saving the latest configuration
to disk and changing the configuration state to read-only mode. You must also
stop VCS before attempting the upgrade process.
To save and close the configuration
1

Open the VCS Java Console.

2

Click Save and Close Configuration on the Cluster Explorer toolbar.

To take the service groups offline
1

From the command prompt, type the following on the command prompt:
C:\>hagrp -offline group_name -sys system_name

where group_name is the name of the service group and system_name is the
node on which the group is online.
2

Repeat this command for all service groups that are online.

To stop VCS GUIs
1

From the Cluster Manager (Java Console), click File > Logout on the Cluster
Explorer window and then click File > Exit on the Cluster Monitor window.

2

For Cluster Management Console (CMC), click Logout on the title bar of the
Cluster Management Console.

To stop VCS services
1

Stop HAD on all the cluster nodes. Type the following on the command
prompt:
C:\>hastop -all -force

2

Stop the Veritas Command Server service on all the cluster nodes. Type the
following on the command prompt:
C:\>net stop cmdserver

3

Stop GAB and LLT on all the cluster nodes. Type the following on the
command prompt:
C:\>net stop gab
C:\>net stop llt
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Backing up customized type definitions
The cluster type definitions are reset to their default values after the upgrade. If
you have modified the values of type definitions in the cluster, make a backup
copy of the types.cf file before the upgrade. You will have to update the type
definition default values after the upgrade.
The types.cf file is located at %VCS_HOME%\conf\config.
The variable %VCS_HOME% is the default installation directory for VCS,
typically C:\Program Files\VERITAS\Cluster Server.
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Upgrading to VCS 5.1
Make sure to select the same agents and options while upgrading the software. If
you do not want to include the enterprise agents and options in the upgraded
cluster, uninstall the agents from the cluster before proceeding.

Changing driver signing options
When upgrading on systems running Windows Server 2003, you must set the
Windows driver signing option to ignore software authentication warning
messages.
To change the driver signing options
1

Open the Control Panel and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, note the current setting, and
select Ignore.

4

Click OK.

5

Repeat for each node in the cluster.

If you do not change these options, the installer rejects the node at validation
and halts the upgrade. After you complete the upgrading, you should reset the
driver signing options to their previous state.
To upgrade the product using the installer
1

Allow the autorun feature to start the installation or double-click
Setup.exe.

2

Choose the default language for your installation and click OK. The product
selection screen appears.

3

Click Veritas Cluster Server 5.1 for Windows.

4

If asked, click Complete/Custom to begin installation, otherwise continue to
the next step.

5

Review the welcome message and click Next.

6

If you agree to the terms of the license agreement, click Next.

7

Enter the product license key before adding license keys for features.
■

Enter the license key in the top field and click Add.

■

Repeat for additional license keys.
■

To remove a license key, click the key to select it and click Remove.

■

To see the license key’s details, click the key.

37

38 Upgrades
Upgrading to Veritas Cluster Server 5.1

■

Click Next.

8

Select the appropriate product options and click Next.

9

Select the appropriate installation options and click Next.
If any previous VCS agents and options are installed on the node, make sure
you select the same agents and options while upgrading. If you do not want
to include the agents and options in the upgraded cluster, uninstall them
from the cluster before proceeding.

10 To install the client components on all the nodes in your installation, verify
that the check box is checked.
Click Next.
11 Specify the domain and nodes for the upgrade.
■

Select the domain and the node. These lists can take some time to
populate depending on domain and network size, speed, and activity.

■

To add a computer for installation, click Add. You can also type the
computer’s name in the Computer field.
To remove a computer, click the computer in the Selected Computers
for Installation field, and click Remove.

■

Repeat the above steps for each node.
Click a computer’s name to see its description.

■

Click Next.

12 The installer checks the prerequisites for the selected computers and
displays the results. Review the information and click Next.
Note that the Install Type for the nodes is listed as Upgrade. If an error
occurs, address the problem described in the Details box.
13 If the installer has detected problems, review the messages, taking action
where necessary, and click Yes.
14 Review the information and click Install. Click Back to make changes.
15 If the installation is successful on all nodes, the installer automatically
proceeds to the installation report. Click Next.
If an installation fails, click Next to review the report and address the
reason for failure. You may have to either repair the upgrade or uninstall
and re-install the upgrade to continue.
If a security alert asks you to accept the Veritas driver software, click Yes.
16 Reboot the remote nodes. Note that you cannot reboot the local node now,
and that failed nodes are unchecked by default.
■

Click the check box next to the remote nodes that you want to reboot.

■

Click Reboot.
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■

When the nodes have finished rebooting successfully, the Reboot
Status shows Online and the Next button is available.

■

Click Next.

17 Review the log files and click Finish.
18 Click Yes to reboot the local node.
To ensure a secure system environment, change the driver signing options for
the remote Windows Server 2003 systems to the original state of Warn or Block.
To reset the driver signing options
1

Open the Control Panel, and click System.

2

Click the Hardware tab and click Driver Signing.

3

In the Driver Signing Options dialog box, reset the option to Warn or Block.

4

Click OK and repeat for each upgraded system.

After upgrading to VCS 5.1 run the following command to check the state of the
cluster:

C:\> hasys -state
If the cluster goes to "stale admin wait" state, then modify the main.cf file as per
the following procedure.
1

Stop the Veritas High Availability Engine (HAD) on all the cluster nodes.
Type the following on the command prompt:

C:\>hastop -all -force
2

On a cluster node, open the cluster configuration file main.cf from the
%VCS_HOME%\conf\config directory and modify it as follows:
Add curly brackets enclosing the Initiator entry. The Initiator entry should
be as follows:
Initiator @THORPC126 = {“iqn.1991-05.com.microsoft:
THORPC126.veritas.com”}

3

Start the Veritas High Availability engine (HAD) on the node where main.cf
was modified.
Type the following on the command prompt:

C:\> hastart
Make sure that HAD is in the RUNNING state on the node.
4

Start the Veritas High Availability engine (HAD) on the remaining cluster
nodes.
Type the following on the command prompt:
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C:\> hastart -all
You can now bring the service groups online.

Tasks after upgrading to VCS 5.1
Tasks after upgrading VCS may include the following tasks, depending on the
environment at the site:
■

“Re-installing VCS Management Console 5.1” on page 40

■

“Modifying PrintShare service groups after upgrading VCS” on page 40

■

“Importing the VCS Management Pack” on page 41

■

“Changing the type definition default values” on page 41

Re-installing VCS Management Console 5.1
To re-install VCS Management Console
1

Install VCS Management Console 5.1.
Refer to the Veritas Cluster Server Management Console Implementation
Guide.

2

Restore the backed up VCS Management Console 5.1 data files.
See “Removing VCS Management Console 5.1” on page 34.

3

Start the VCS Management Console. If the management console is
clustered, bring the CMC_MS service group online.

Modifying PrintShare service groups after upgrading VCS
The PrintShare agent is modified to address performance issues in cases where
a large number of printshare resources are configured in a service group. A new
process, PrintMonitor.exe, handles the printer addition notifications and
configures regrep resources for them.
If you have PrintShare service groups in the cluster, you must run the Print
Share Configuration wizard after upgrading VCS. The wizard modifies existing
PrintShare service groups per the new changes to the PrintShare agent.
Note: Do not add or remove any resources, or modify any other attributes in the
print share service group for the first time you run the Print Share
Configuration Wizard to modify the service group.
Before you modify the existing print share service group:
■

Make sure that the VCS engine (HAD) is running on the cluster node.
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■

Mount the drives or LUNs that contain the spooler and the registry
replication directories on the system on which you will run the wizard.

To modify the print share service group after an upgrade
1

Start the Print Share Configuration Wizard. (Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Wizards > Print Share
Configuration Wizard)

2

Read the information on the Welcome panel and click Next.

3

On the Wizard Options panel, click Modify service group, select your
existing print share service group, and then click Next.

4

Click Next on the subsequent wizard panels and complete the wizard steps.
You can now bring the printshare service group online.

Importing the VCS Management Pack
This rollup patch contains fixes for the VCS Management Pack. If you have
deployed the VCS Management Pack for Microsoft Operations Manager 2005 in
your cluster environment, you can re-import the updated VCS Management
Pack after installing the rollup patch.
The updated VCS Management Pack is included with the rollup patch software.
Import the appropriate VCS Management Pack (.akm file) using the MOM 2005
SP1 Administrator Console.
While importing the management pack, ensure that you select the Update
existing Management Pack option in the Management Pack Import/Export
Wizard.

Changing the type definition default values
The cluster type definitions are reset to their default values after the upgrade.
Refer to the backup copy of the types.cf file. Use the Cluster Manager (Java
Console) to change the type definition default values with the values from the
types.cf backup file.
Note: Do not replace the types.cf file with the backup copy after the upgrade.
The backup copy must be used only as a reference for the customized type
definition values in the cluster.
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Microsoft Service Pack upgrades
This section covers:
■

Configuring Microsoft Exchange 2003 SP2 in a VCS environment

■

Configuring Microsoft Exchange 2007 SP1 in a VCS environment

■

Configuring Microsoft SQL 2000 SP4 in a VCS environment

■

Configuring Microsoft SQL 2005 SP2 in a VCS environment

Configuring Microsoft Exchange 2003 SP2 in a VCS environment
This section covers configuring Microsoft Exchange 2003 SP2 in a VCS
environment, if you already have Microsoft Exchange 2003 installed and want to
apply Exchange 2003 SP2.

Prerequisites
Before upgrading to Microsoft Exchange 2003 SP2, make sure to set the
"DetailMonitor" attribute of all "ExchService" type resources to zero.
Perform the following steps to upgrade an Exchange 2003 installation on a node
that is part of the Exchange service group. Make sure all the nodes, which are
part of the Exchange service group, have the same version and service pack level
as Microsoft Exchange.
To upgrade to Microsoft Exchange 2003 SP2
Make sure that you do not mount the Exchange databases on the failover nodes.
1

Bring the Exchange service group online, on the node where you are
upgrading the Exchange installation .

2

Stop HAD on the node where Exchange installation will be upgraded. At the
command prompt, type:
C:\> hastop -local -force

3

Install Microsoft Exchange 2003 SP2 on the node where the service group is
online. If prompted to install the hotfix for Internet Information Services
(IIS) 6.0, refer to the Microsoft Knowledge Base Article: 831464.

4

Start HAD on the node. At the command prompt, enter:
C:\> hastart

5

Take offline the Exchange service group on the node after the installation.

6

Restart WMI services on the node.

7

Repeat step 1 through step 6 on all remaining nodes that are part of the
Exchange service group.
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8

Update the ExchConfig registry information on every system where
Exchange is upgraded. To update the registry on the local system, navigate
to the %vcs_home%\bin\ExchSetup folder and enter the following
command at the command prompt:
Setup.exe /UpdateExchVersion
To update the registry on more than one system enter:
Setup.exe /UpdateExchVersion system_name1 system_name2
...

Configuring Microsoft Exchange 2007 SP1 in a VCS environment
This section describes the steps to configure Exchange 2007 SP1 using the
Exchange 2007 Upgrade Wizard. It is applicable only if you already have
Exchange 2007 set up in a VCS cluster environment.

Prerequisites
Before you proceed with the Exchange 2007 upgrade, do the following:
■

Ensure that the Exchange 2007 service group is offline in the cluster.
While performing the upgrade the Exchange 2007 Upgrade Wizard
renames and then restarts the cluster node.

■

Exit all other programs before you run the wizard on a cluster node.

Complete the following steps on all cluster nodes that are part of the Exchange
2007 service group, one node at a time.
To upgrade Exchange 2007 to Exchange 2007 SP1
1

On one of the cluster nodes, click Start > Programs > Symantec > Veritas
Cluster Server > Configuration Tools > Exchange 2007 Upgrade Wizard to
start the Exchange 2007 Upgrade wizard.

2

Review the information on the Welcome panel and click Next.

3

On the Exchange Virtual Server Selection panel, select the Exchange virtual
server that you wish to upgrade and then click Next.
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The Summary table provides the details of the Exchange virtual servers in
the cluster and their upgrade status on each cluster node.

4

The wizard performs the tasks required to set up the VCS environment for
the Exchange upgrade. The Tasks table displays the progress of the various
tasks. After all the tasks are completed, click Next.

5

Review the information on the Cluster Node Reboot panel and then click
Reboot. The wizard prompts you to reboot the node. Click Yes to reboot the
node.
The Exchange virtual server name is temporarily assigned to the cluster
node. On rebooting the node, the Exchange 2007 Upgrade Wizard is
launched automatically with a message that the Exchange pre-upgrade
tasks are complete. Do not click Continue at this time. Wait until after the
Exchange upgrade is complete.

6

Run the Exchange 2007 SP1 installer to upgrade Exchange 2007 on the
node. Type the following at the command prompt:

<drive letter>:\setup.com /mode:Upgrade
Here <drive letter> is the drive where the Exchange SP1 installer is
located.
Note: You can also run Setup.exe to launch the installer GUI for upgrading
Exchange. If using the installer GUI, ensure that you do not select any other
Exchange 2007 server role. Only the Mailbox server role must be upgraded.
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Verify that the upgrade has completed successfully. In case the upgrade has
partially succeeded or has failed, resolve the error and ensure that the
upgrade is successful. Refer to the Microsoft Exchange documentation for
more information.
7

Return to the Exchange 2007 Upgrade Wizard and click Continue.
If the wizard is not running, click Start > Programs > Symantec > Veritas
Cluster Server > Configuration Tools > Exchange 2007 Upgrade Wizard to
start the wizard and then click Next.

8

The wizard performs the tasks required to set up the VCS environment after
the Exchange upgrade. The Tasks table displays the progress of the various
tasks. After all the tasks are completed, click Next.

9

Review the information on the completion panel and then click Finish.
The wizard displays the status of the Exchange virtual server upgrade. The
Summary table provides the details of the Exchange virtual servers in the
cluster and their upgrade status on each cluster node.

10 Repeat these steps on the remaining cluster nodes. After you have upgraded
all the cluster nodes that are configured to host the Exchange virtual server,
bring the Exchange 2007 service group online in the cluster.
Note: Do not bring the Exchange 2007 service group online until you have
completed the upgrade on all the cluster nodes that are part of the service
group.

Upgrade considerations in case of multiple Exchange virtual servers
Consider the scenario where there are multiple Exchange virtual server
instances in the cluster (an any-to-any configuration).
Table 3-1 describes the configuration objects.
Table 3-1

Exchange 2007 SP1 upgrade configuration objects

Object

Description

Node1, Node2, Node3

Physical node names

EVS1, EVS2

Exchange virtual servers

The configuration is such that:
■

EVS1 can fail over on Node1 and Node2.

■

EVS2 can fail over on Node3 and Node2.

So, Node2 is the common failover node for EVS1 and EVS2.
In this case, upgrade the Exchange virtual servers as follows:
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■

Upgrade EVS1 on Node1.

■

Upgrade EVS2 on Node3.

■

And then upgrade either EVS1 or EVS2 on Node2.
You must upgrade Node2 (common failover node) only once; the Exchange
virtual server (whether EVS1 or EVS2) does not matter.

In general, for multiple Exchange virtual servers, upgrade each Exchange
virtual server on one cluster node first, and then upgrade any one of the
Exchange virtual servers on the common failover nodes.

Configuring Microsoft SQL 2000 SP4 in a VCS environment
This section outlines the procedure needed to install Microsoft SQL 2000 Server
Service Pack 4 on a computer running Veritas Cluster Server.

Prerequisites
Before applying Microsoft SQL 2000 SP4 to a production server make sure that
you have a recent backup of your system and user databases. Server down time
is required for this procedure.
Note: This procedure assumes you have a recent flat-file backup of the MSSQL
Data Files directory on the shared disk, in this example,
S:\MSSQL$SQL2000.SP3A, and that your current SQL directory is called
S:\MSSQL$SQL2000, in this example, on the same drive letter. If yours are
named differently, substitute your directory names where appropriate.
To install Microsoft SQL 2000 Server SP4
1

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group and select Offline on all nodes.

2

On the node where the SQL Server Service Group was taken offline, online
the NetAppSnapDrive resource for the shared drive containing the SQL
databases (for example, S:\MSSQL$SQL2000).

3

On the shared disk, make a copy of your recent MSSQL data files directory
(S:\MSSQL$SQL2000) and rename it, for example to S:\MSSQL$2000.SP3A.

4

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is now partially online, and select Freeze >Persistent.

5

Install Microsoft SQL 2000 Service Pack 4 on the active node (where the SQL
Server Service Group is partially online), using the instructions provided by
Microsoft.
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6

Repeat step 5 for each additional SQL instance in this service group, if you
have more than one instance in this service group.

7

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is still online and select Unfreeze.

8

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group and select Offline on the node where it was online.

9

In a Disaster Recovery environment, switch the Replication Service Group
to one of the other, additional or failover nodes in this cluster.

10 On the failover node, online the NetAppSnapDrive resource for the shared
drive containing the SQL databases (for example, S:\MSSQL$SQL2000).
11 On the shared disk, rename the S:\MSSQL$SQL2000 directory to
S:\MSSQL$SQL2000.SP4. If S:\MSSQL$SQL2000.SP4 already exists on the
shared disk, then delete it before renaming the S:\MSSQL$SQL2000
directory.
12 On the shared disk, rename the S:\MSSQL$SQL2000.SP3A directory to
S:\MSSQL$SQL2000. If there are additional nodes in this cluster to be
updated, copy the S:\MSSQL$SQL2000.SP3A directory to
S:\MSSQL$SQL2000 instead of renaming the directory.
13 From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is now online and select Freeze >Persistent.
14 Install Microsoft SQL 2000 Service Pack 4 on the active node (where the SQL
Server Service Group is online), using the instructions provided by
Microsoft.
15 Repeat step 14 for each additional SQL instance in this service group, if you
have more than one instance in this service group.
16 From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is still online and select Unfreeze.
17 From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group and select Offline on the node where it was online.
18 Repeat step 9 through step 17 on each additional node if more than two SQL
2000 nodes are in use.
19 For a Disaster Recovery environment, repeat this procedure at the
secondary site.
20 When Microsoft SQL 2000 Server Service Pack 4 has been completely
installed on all nodes, test user connectivity to the instances.
21 Test the SQL Server Service Group by bringing it online and failing it over
from node to node. When testing is complete, the upgrade is complete.

47

48 Upgrades
Microsoft Service Pack upgrades

22 If more than one SQL Server Service Group is present, repeat this entire
procedure for each SQL Server Service Group.

Configuring Microsoft SQL 2005 SP2 in a VCS environment
This section outlines the procedure needed to install Microsoft SQL 2005 Server
SP2 on a computer running Veritas Cluster Server.

Prerequisites
Before applying Microsoft SQL 2005 Server SP2 to a production server make
sure that you have a recent backup of your system and user databases. Server
down time is required for this procedure.
Note: This procedure assumes you have a recent flat-file backup of the MSSQL
Data Files directory on the shared disk, in this example, S:\Microsoft SQL
Server, and that your current SQL directory is called S:\MSSQL$SQL2000, in
this example, on the same drive letter. If yours are named differently, substitute
your directory names where appropriate.
To install Microsoft SQL 2005 Server SP2
1

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group and select Offline on all nodes.

2

On the node where the SQL Server Service Group was taken offline, online
the SQL 2005 resource for the shared drive containing the SQL databases.

3

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is now partially online, and select Freeze >Persistent.

4

Verify that the SQL Server service group is partially online on the node
where Microsoft SQL 2005 Service Pack 2 is to be installed. Install Microsoft
SQL 2005 Service Pack 2 on the active node (where the SQL Server Service
Group is partially online), using the instructions provided by Microsoft.

5

Repeat step 4 for each additional SQL instance in this service group, if you
have more than one instance in this service group.

6

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is still online and select Unfreeze.

7

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group and select Offline on the node where it was online.

8

On the failover node, online the SQL 2005 resource for the shared drive
containing the SQL databases.
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9

From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is now online and select Freeze >Persistent.

10 Install Microsoft SQL 2005 Service Pack 2 on the active node (where the SQL
Server Service Group is online), using the instructions provided by
Microsoft SQL Server 2005 Service Pack 2 Setup.
11 Repeat step 10 for each additional SQL instance in this service group, if you
have more than one instance in this service group.
12 From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group which is still online and select Unfreeze.
13 From the Veritas Cluster Manager Console, right-click the SQL Server
Service Group and select Offline on the node where it was online.
14 Optionally reboot and online each service group to verify the database
connect for each node.
15 Repeat step 8 through step 14 on each additional node if more than two SQL
2005 nodes are in use.
16 For a Disaster Recovery environment, repeat this procedure at the
secondary site.
17 When Microsoft SQL 2005 Server Service Pack 2 has been completely
installed on all nodes, test user connectivity to the instances.
18 Test the SQL Server Service Group by bringing it online and failing it over
from node to node. When testing is complete, the upgrade is complete.
19 If more than one SQL Server Service Group is present, repeat this entire
procedure for each SQL Server Service Group.
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Upgrading an Exchange Server cluster
This section describes the upgrade scenarios and upgrade tasks for upgrading to
VCS 5.1 in an Exchange 2003 cluster.
If you have an Exchange 2007 setup you may want to update Exchange with a
service pack after upgrading VCS. For information on updating Exchange
service packs, see “Configuring Microsoft Exchange 2007 SP1 in a VCS
environment” on page 43.

Upgrade scenarios
The following table presents possible scenarios for upgrading to a VCS 5.1
cluster with Microsoft Exchange.

Table 3-2

Upgrade scenarios

Upgrade From

Upgrade To

VCS
Version

Operating
System

Exchange
Version

4.3, 5.0 or
5.0 RP1a

Windows Server Exchange
2003
2003

VCS
Version

Operating
System

Exchange
Version

5.1

Windows
Server 2003

Exchange
2003

Upgrade tasks
■

Stop VCS Services before upgrading.
See “Preparing to upgrade to VCS 5.1” on page 34.

■

Upgrade VCS to version 5.1.
See “Upgrading to VCS 5.1” on page 37.
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Upgrading a SQL Server cluster
This section provides information about upgrading to VCS 5.1 in a SQL Server
cluster.
This section also provides information about upgrading from Microsoft SQL
Server 2000 to SQL Server 2005. To upgrade SQL Server 2000 to SQL Server
2005, see “Upgrading from Microsoft SQL Server 2000 to SQL Server 2005” on
page 52.
Note: If you are upgrading both Microsoft SQL Server and VCS, then you must
upgrade SQL Server first and then proceed with upgrading VCS.

Upgrade scenarios
The following table presents possible scenarios for upgrading to a VCS 5.1
cluster with SQL Server.
Table 3-3

Upgrade scenarios

Upgrade From
VCS version

Upgrade To
Operating
System

SQL Server VCS
version
version

Operating
System

SQL Server
version

■

4.3, 5.0 or
5.0RP1a

Windows
Server 2003

SQL 2000

5.1

Windows
Server 2003

SQL 2000

■

4.3, 5.0 or
5.0RP1a

Windows
Server 2003

SQL 2005

5.1

Windows
Server 2003

SQL 2005

Upgrade tasks
■

Stop VCS Services before upgrading.
See “Preparing to upgrade to VCS 5.1” on page 34.

■

Upgrade VCS to version 5.1.
See “Upgrading to VCS 5.1” on page 37.
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Upgrading from Microsoft SQL Server 2000 to SQL Server 2005
The sequence for upgrading SQL Server and VCS is as follows:
■

Upgrade SQL Server on the first node

■

Upgrade SQL Server on each additional node

■

Create the SQL Server 2005 service group

■

Upgrade VCS 4.3, 5.0 or 5.0RP1a to VCS 5.1

Additionally you may want to upgrade SQL Server service pack. For information
on upgrading service packs, see “Configuring Microsoft SQL 2005 SP2 in a VCS
environment” on page 48.
To upgrade SQL Server on the first node
1

Bring online the SQL 2000 service group resources up to the SQL Server
2000 resource. Right-click each resource and select Online. Click Yes in the
confirmation pop-up to bring the resource online. This action brings online
the disks, volumes, and IP address associated with SQL Server.

2

Right-click the SQL Server service group in treeview and click Freeze >
Persistent.

3

Back up the SQL Server 2000 (MSSQL) and Registry (RegRep) folders on the
shared disk by making a copy of each.

4

Start SQL Server 2000 under a local node context. Click Start > Run and
type services.msc.

5

In the Services panel, find MSSQLServer, right-click it, and select Start.

6

Launch the Microsoft SQL Server 2005 installer and proceed through the
installation process.
Make sure that you select the option to upgrade the existing instance(s)
when prompted to do so. This action automatically places the data files in
the proper location.
Note: Depending on the circumstances, an in-place upgrade may not be
suitable for your environment. Refer to Microsoft documentation before
beginning any SQL Server upgrade.

7

Reboot the node if requested to do so when the installation completes.

8

Unfreeze and take offline the service group on the first node if you did not
reboot. (Rebooting automatically takes the service group offline.)

Once you have completed the upgrade procedure on the first node, you must
perform the following steps on each additional node in the cluster.
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To upgrade SQL Server on each additional node
1

Bring online the SQL 2000 service group resources up to the SQL Server
2000 resource, but do not online the regrep resources. Right-click each
resource and select Online. Click Yes in the confirmation pop-up to bring
the resource online.

2

Restore the copies of the SQL Server 2000 (MSSQL) and Registry (RegRep)
folders on the shared disk. Delete the original MSSQL and RegRep folders.

3

Bring online the regrep resources (right-click and select Online).

4

In the treeview, freeze the service group (right-click and
select Freeze > Persistent).

5

Start SQL Server 2000 under a local node context. Click Start > Run and
type services.msc.

6

In the Services panel, find MSSQLServer, right-click it, and select Start.

7

Launch the Microsoft SQL Server 2005 installer and proceed through the
installation process.
Make sure that you select the option to upgrade the existing instance(s)
when prompted to do so. This action automatically places the data files in
the proper location.
Refer to your Microsoft SQL Server 2005 documentation for more detailed
instructions on installing Microsoft SQL Server.

8

Reboot the node if requested to do so when the installation completes.

9

Unfreeze and take offline the service group on the secondary or additional
node if you did not reboot. (Rebooting automatically takes the service group
offline.)

Once you have completed upgrading all of the nodes in the SQL Server cluster,
continue with creating the service group.
To create the SQL Server 2005 service group
1

On the first node, bring online the SQL Server resources from the SQL2000
service group. Right-click the resource, select Online, and select the first
node.

2

Delete the existing SQL2000 service group (in treeview). Right-click the
service group and select Delete. Click Yes when asked to confirm if you
want to delete the service group.

3

Create the SQL2005 service group using the SQL Server Configuration
Wizard. Click Start > All Programs > Symantec > SQL Server Configuration
Wizard.
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4

Test switch the service group to another node in the cluster. Right-click the
service group in treeview, select Switch To, and select any additional node
in the cluster.

Proceed with upgrading VCS. See “Upgrading to VCS 5.1” on page 37 for detailed
steps on using the installer to upgrade to VCS 5.1.

Appendix

A

Services and ports used by
VCS
If you have configured the Windows firewall, ensure that the firewall settings
allow access to the services or ports used by VCS.
Table A-1 displays the services and ports used by VCS.
Note: Port numbers appearing in bold are mandatory for configuring VCS.

Table A-1

VCS services and ports

Port Number Protocol

Description

2148, 3207

TCP/UDP

Veritas Enterprise Administrator (VEA) Server (vxsvc.exe)

14150

TCP

VCS Command Server (CmdServer.exe)

14141

TCP

Veritas High Availability Engine (had.exe)
Veritas Cluster Manager (Java console)
(ClusterManager.exe)
VCS Agent driver (VCSAgDriver.exe)

7419

TCP

Solutions Configuration Center (SFWConfigPanel.exe)
CCF Engine (CEngineDriver.exe)
CCF Plugin Host (PluginHost.exe)

1099

TCP/UDP

Provider Access Layer (VxPAL.exe)

1556

TCP/UDP

Private Branch Exchange (pbx_exchange.exe)

2821

TCP/UDP

Veritas Security Services (VxSS)

8181, 14145

TCP/UDP

Veritas Cluster Management Console (CMC)
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Table A-1

VCS services and ports (Continued)

Port Number Protocol

Description

14443

TCP

Veritas CMC Management Server. Used as SSL port for
VRTSWeb.

4145

UDP

VCS Cluster Heartbeats

8443

TCP

VCS Secure Web Server

14144

TCP/UDP

VCS Notification

14153,

TCP/UDP

VCS Cluster Simulator

14155

TCP/UDP

VCS Global Cluster Option (GCO)

14300

TCP/UDP

VRTSWeb Admin

15550 - 15558
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